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About vRealize Network Insight
Installation Guide

The vRealize Network Insight Installation Guide is intended for administrators or specialists responsible
for installing vRealize Network Insight.

Intended Audience

This information is intended for administrators or specialists responsible for installing
vRealize Network Insight. The information is written for experienced virtual machine administrators who
are familiar with enterprise management applications and datacenter operations.

VMware Technical Publications Glossary

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For
definitions of terms as they are used in VMware technical documentation, go to
http://www.vmware.com/support/pubs.

VMware, Inc.
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Preparing for Installation

Before you install vRealize Network Insight, prepare the deployment environment to meet the system
requirements.

This chapter includes the following topics:

m  System Recommendations and Requirements

m  Supported Products and Versions

System Recommendations and Requirements

For optimum performance, the minimum recommendations for the deployment are as follows:

Recommendations for the Platform Deployment
For non-cluster deployment:

Table 1-1. Non-Cluster Deployment

CPU(Numbe Number of Flows per Flow
Brick Size r of cores) RAM Disk VMs Day Total Flows Planning
Medium 8 32 GB 750 GB 4000 1 million 10 million 2 million
Large 12 48 GB 750 GB 6000 2 million 10 million 4 million
Note
m  The reservation for the CPU speed and RAM for each node should be 100% of the value specified
above.

= The count of VMs includes the templates on the vCenter as well.

®m  The network latency between the platform nodes should be less than 500ms.

For cluster deployment:
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Table 1-2. Cluster Deployment

Brick Size
Large

Extra
Large

Extra
Large

Extra
Large

Cluster
Size
(Number
of nodes)
3

3

Total CPU
( Number
of cores)

36

48

80

160

Total RAM
144 GB

192 GB

320 GB

640 GB

Total Disk
37TB

6TB

10TB

20TB

Number of Flows per
VMs Day

10,000 2 million

18,000 6 million

30,000 10 million

60,000 10 million

Note For
supporting
60,000
VMs on a
10-node
cluster,
contact
VMware
Support.

Total
Flows

10 million

10 million

10 million

10 million

Flow
Planning

4 million

4 million

4 million

4 million

Note Each brick in the cluster configuration mentioned in the above table refers to the following
recommendation.

Table 1-3. Cluster Deployment: Individual Brick Size

Brick Size
Large

Extra Large

Note

CPU per Node (Number of

Cores)

12

16

RAM per Node (GB)

48

64

Disk per Node (TB)

m  The reservation for the CPU speed and RAM for each node should be 100% of the value specified

above.

= For a large cluster deployment model that has more than 5 nodes, the Platform1 node might need

more than 2 TB of disk space.
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Recommendation for the Collector Deployment
Table 1-4.

CPU ( Number of
Collector Size Cores) RAM Disk Number of VMs Flows per Day

Medium 4 10 GB 150 GB 4000 2.5 million
Large 6 12GB 150 GB 6000 5 million

Note For support
on adding 10,000
VMs on a large
collector, contact
VMware Support.

Extra Large 6 36 GB 150 GB 6000 10 million

Note For extra
large collector
configuration and
support for adding
10,000 VMs ,
contact VMware
Support.

Note

m  The reservation for the CPU speed and RAM for each node should be 100% of the value specified
above.

m  The count of VMs includes the templates on the vCenter as well.

m  For all the extra large configurations, contact VMware support.

Other Requirements and Considerations

®  The maximum time skew between the platform nodes has to be lesser than 30 seconds.

= The availability of the NTP service is critical to system operations. Ensure that you do not reboot the
platform node or the collector node when the NTP service is not available.

= vRealize Network Insight services crashes and does not recover automatically when the existing
compute resources are used up by the other processes on the platform. If the services fail to recover,
reboot the platform node.

Supported Browser

m  Google Chrome or Mozilla Firefox Web browser

Privileges
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Privileges Required for Data Sources

m  Privileges required to configure and use IPFIX
= vCenter Server Credentials with privileges:
m  Distributed Switch: Modify
= dvPort group: Modify

m  The predefined roles in the vCenter server must have the following privileges assigned at root
level that need to be propagated to the children roles:

= System.Anonymous
= System.Read
= System.View
= global.settings
m  Privileges required for NSX Manager Data Provider
m  NSX Manager Data Provider requires the Enterprise role.

m  |f Central CLI is enabled, then the system admin credentials are required for NSX Manager Data
Provider.

m  User privileges required on Cisco switches for metrics collection

= vRealize Network Insight is capable of collecting metric data via SNMP as well as configuration
via SSH from Cisco Switches. Cisco Switches UCS platform requires the use of both SSH and
API for collection.

Table 1-5.
Type of data User Privileges
Configuration Data Read-Only
Metric Data SNMP read-only

SNMPv2 read-only SNMP community

SNMPv3 read-only

System Ports

The following tables list all the vRealize Network Insight inbound communication ports that need to be
whitelisted for various setups:

VMware, Inc. 8
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Ports for the Platform Cluster Setup

Table 1-6.
Authenticati
Source Target Port Protocol Purpose Sensitive SSL on
SSH client Platform 22 SSH CLI or host No Yes User/Passwo
access rd or SSH
key-based
authenticatio
n
Client Web- Platform 443 HTTPS UI/API Yes Yes SSL channel
Browser and access and encrypted
VRNI Proxy communicati with 2048b
on with vRNI RSA key
Proxy based SHA2
cert (or User
configured
custom cert).
Proxy to
Platform
messages on
this channel
also
encrypted
further with
HMAC.
Platform Platform 2181 HTTP Communicati  No No
on between
zookeeper
servers on
other nodes
(in case of
cluster). And
stores
metdata
information(z
node data)
Platform Platform 2888 HTTP Used to No No
connect to
zookeeper
leader
Platform Platform 3000 HTTP Used for Yes No
email
notifications
Platform Platform 3888 HTTP Used for Yes No
zookeeper
leader
election
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Table 1-6. (Continued)

Source

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

VMware, Inc.

Target

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Port

5432

8020

8025

8030

8032

8033

8042

8080

8088

8480

8485

Protocol

jdbc

TCP/RPC

HTTP

HTTP

HTTP

HTTP

HTTP

HTTP

HTTP

TCP/RPC

TCP/RPC

Purpose

Storing VM
configuration
data and
infra meta
data

Communicat
e between
other name
node(s) and
data nodes

Node
managers
use this port
to connect to
resource
manager

Used by
resource
manager to
schedule the
tasks

The address
of the
applications
manager
interface in
the RM

The address
of the RM
admin
interface

Node
manager web
app address

Serves Ul
requests

The HTTP
address of
the Resource
Manager web
application

JournalNode
HTTP server

HDFS shared
edits data dir

Sensitive

Yes

Yes

No

No

No

No

No

Yes

No

No

No

SSL

No

No

No

No

No

No

No

No

No

No

No

Authenticati
on
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Table 1-6. (Continued)

Authenticati
Source Target Port Protocol Purpose Sensitive SSL on
Platform Platform 9090 HTTP Serves Yes Yes
requests (protected via
from proxy nginx)
and sends

commands to

proxy
Platform Platform 9092 Binary over Port on which  Yes No
TCP other brokers

communicate

Platform Platform 9200-9300 HTTP Serves Yes No
search
requests. ES
uses range of
ports to
listen, if 9200
is by it uses
next port
available.

Platform Platform 9300 HTTP Serves Yes No
search
requests. ES
uses range of
ports to
listen, if 9200
is by it uses
next port
available.

Platform Platform 30000:65535 TCP Ephemeral No No
ports range
used by
various
processes to
make the
TCP
connection
with the other
processes

Platform Platform 60000 IPC Used for Yes No
communicati
on between
other hbase
masters and
region
servers
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Table 1-6. (Continued)

Authenticati
Source Target Port Protocol Purpose Sensitive SSL on
Platform Platform 60010 HTTP Used for No No
hbase web
ul
Platform Platform 60020 IPC Communicati  Yes No
on between
hbase master
and region
server
Ports for the Single Platform Setup
Table 1-7.
Authenticati
Source Target Port Protocol Purpose Sensitive SSL on
SSH client Platform 22 SSH CLI or host No Yes User/Passwo
access rd or SSH
key-based
authenticatio
n
Client Web- Platform 443 HTTPS UI/API Yes Yes SSL channel
Browser and access and encrypted
VRNI Proxy communicati with 2048b
on with vRNI RSA key
Proxy based SHA2
cert (or User
configured
custom cert).
Proxy to
Platform
messages on
this channel
also
encrypted
further with
HMAC.
VMware, Inc. 12
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Ports for the Proxy Server

Table 1-8.
Authenticati
Source Target Port Protocol Purpose Sensitive SSL on
SSH client Proxy 22 SSH CLI or host No Yes User/Passwo
access rd or SSH
key-based
authenticatio
n
VRNI Proxy Platform 443 HTTPS Primary Yes Yes SSL channel
communicati encrypted
on channel with 2048b
with Platform RSA key
based SHA2
cert (or User
configured
custom cert).
Proxy to
Platform
messages on
this channel
also
encrypted
further with
HMAC.
Flow Proxy UDP 2055 NetFlow/IPFI  Flows from Yes No
Forwarder X target are
pushed to
this port

Network Communication Ports

The following table lists the ports and the protocols that are used for the network communication in
vRealize Network Insight:

Table 1-9.
Purpose From To Port Protocol
Communication Collector Platform 443 HTTPS

between the VMs of
VvRealize Network
Insight
Services that require Platform and Collector ~ svc.ni.vmware.com 443 HTTPS
Internet access .
support2.ni.vmware.co
m

reg.ni.vmware.com

VMware, Inc. 13
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Table 1-9. (Continued)

Purpose

Communication for
miscellaneous services
configured

From

Platform

Platform and Collector

ESXi Hosts
Communication with Collector
AWS as a data source
Communication with Collector

other data sources
within the data center

To

LDAP server
SNMP server
DNS server
Syslog server
Collector

AWS(*.amazonaws.co
m)

Avrista switches
Brocade switches
Check Point firewall
Cisco Nexus

Cisco UCS (Unified
Computing System)

Cisco Catalyst
switches

Dell switches

HP

Juniper Switches
Palo Alto Networks
VMware vSphere

VMware NSX

Supported Products and Versions

vRealize Network Insight supports several products and versions.

Port Protocol

389, 636 LDAP and LDAPS
Configurable SNMP

53 UDP
Configurable

2055

443 HTTPS

161 and 22 SNMP and SSH
161 and 22 SNMP and SSH
443 HTTPS

161 and 22 SNMP and SSH

161, 22, and 443

SNMP, SSH, and
HTTPS

161 and 22 SNMP and SSH
161 and 22 SNMP and SSH
22 SSH

161 and 22 SNMP and SSH
443 HTTPS

443 HTTPS

22 and 443 SSH and HTTPS

Data Source

Amazon Web
Services
(Enterprise
License Only)

Version/Model

Not Applicable

Arista switches 7050TX, 7250QX,

7050QX-328S, 7280SE-72

Brocade Switches VDX 6740, VDX 6940, MLX,

MLXe

VMware, Inc.

Connection Protocol

HTTPS

SSH, SNMP

SSH, SNMP

Permissions/Privileges

Refer the Adding an AWS Data
Source section in the vRealize
Network Insight User Guide.

Read only user
Read only SNMP user

Read only user
Read only SNMP user

14
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Data Source

Check Point
Firewall

Cisco ASA

Cisco Catalyst

Cisco Nexus

Cisco UCS
(Unified
Computing
System)

Dell switches

HP

Infoblox

Juniper Switches

Palo Alto Networks

VMware NSX-V

VMware, Inc.

Version/Model

Check Point R80

X Series with OS 9.4

3000, 3750, 4500, 6000, 6500

3000, 5000, 7000, 9000

Series B blade servers,
Series C rack servers,
Chassis, Fabric interconnect

FORCE10 MXL 10,
FORCE10 S6000, S4048,
79100, S4810,
PowerConnect 8024

HP Virtual Connect Manager
4.41, HP OneView 3.0

Infoblox NIOS version 8.0,
8.1,8.2

EX3300, QFX 51xx Series
(JunOS v12 & v15, without
QFabric)

Panorama 7.0.x, 7.1, 8.0

Supported Versions

Connection Protocol

HTTPS

SSH, SNMP

SSH, SNMP

SSH, SNMP

UCS Manager: HTTPS
UCS Fabric: SSH, SNMP

SSH, SNMP

HP OneView 3.0: HTTPS

HP Virtual Connect Manager 4.41:
SSH

HTTPS

Netconf, SSH, SNMP

HTTPS

SSH, HTTPS

Permissions/Privileges

Administrator with Read Write
permissions

The Check Point Management
Server should accept API access
from the Collector IP address. It
can be set up from Manage &
Settings > Blades > Management
API > Advanced Settings.

The user should have rights to
switch to the enable mode. The
user's password should be same
as the one used for the enable
mode of Cisco ASA.

Read only SNMP user with default
privilege level 15

Read only user
Read only SNMP user

Read only user
Read only SNMP user

Read only user
Read only SNMP user

Read only user

Read only user with API Interface
access

Read-only permissions for DNS
object types as follows:

m  Permission Type - DNS

m  Resource - A Records, DNS
Zones, DNS Views

Read only user
Read only SNMP user

Read only user

Admin role profile is required for
an administrator.

NSX Manager Data Provider
requires the Enterprise role.

For 6.2.x & 6.3.x if Central CLI is
used, then provide system admin
credentials.
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Data Source
VMware NSX-T

VMware vRealize
Log Insight

VMware vSphere

VMware, Inc.

Version/Model Connection Protocol
Supported Versions HTTPS
Supported Versions HTTPS
Supported Versions HTTPS

For IPFIX, VMware ESXi

version needed:

m 5.5 Update 2 (Build
2068190) and above

® 6.0 Update 1b (Build
3380124) and above

m  VMware VDS 5.5 and
above

Note Vmware tools should
be installed on all the VMs in
the data center to identify the
VM to VM path.

Permissions/Privileges
Read only user

API user with permissions to install,
configure, and manage the content
pack

Read only user

Privileges required to configure and
use IPFIX

vCenter Server Credentials with
privileges:

Distributed Switch: Modify
dvPort group: Modify

The predefined roles in the vCenter
server must have the following
privileges assigned at root level
that need to be propagated to the
children roles:

System.Anonymous
System.Read
System.View

global.settings

16
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Installing
vRealize Network Insight

You can deploy vRealize Network Insight using vSphere Web client or vSphere Windows native client.

Note After you successfully deploy vRealize Network Insight Platform OVA, verify whether the given

static IP is set on vCenter Server.

To automate installation, configuration, upgrade, patch, configuration management, drift remediation and
health from within a single pane of glass, you can use vRealize Suite Lifecycle Manager. If you are a new
user, click here to install vRealize Suite Lifecycle Manager. This provides the IT Managers of Cloud admin
resources to focus on business-critical initiatives, while improving time to value (TTV), reliability and

consistency.

You can also install and upgradevRealize Network Insight by using vRealize Suite Lifecycle Manager. For
more information, see the vRealize Suite Lifecycle Manager Installation, Upgrade, and Management
Guide.

This chapter includes the following topics:

Installation Workflow

Deploying vRealize Network Insight Platform OVA
Activating the License

Generating Shared Secret

Setting up Network Insight Collector (OVA)
Deploy Additional Proxy to an Existing Setup
Default Login Credentials

NSX Assessment Mode for Evaluation License
Add vCenter Server

Analyze Traffic Flows

Generate a Report

Adding Data Sources

VMware, Inc. 17
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Installation Workflow

To install vRealize Network Insight, you install the platform OVA, activate the license, generate shared
secret, and setup proxy OVA.

Note The terms Proxy and Collector are used interchangeably in the documentation.

Install Platform OVA
(Import in vCenter Server)

Open htips://<Platform IP Address=
and activate license

Generate Shared Secret
and Setup Proxy OVA

Log into vRealize Network Insight
and add Data sources

Deploying vRealize Network Insight Platform OVA

You can import the vRealize Network Insight Platform OVA to your vCenter Server.

Deployment using vSphere Web Client

You can deploy vRealize Network Insight using vSphere Web Client.

Procedure
1 Right-click the Datacenter where you want to install the appliance and select Deploy OVF Template.

2 Enter the URL to download and install the OVA package or browse to select the source location of the
OVA package.

3 Enter the OVA name. Select the destination folder for deployment.

VMware, Inc. 18
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Select a host or a cluster or a resource pool where you want to run the deployed template.
Verify the OVF template details.

Read the End User License Agreement and click Accept.

Select a deployment configuration. Click Next.

Select the location to store the files for the deployed template. Select Thin Provision as the Virtual
Disk format. Select the datastore or the datastore clusters where you want to store the files. Click
Next.

Select the network that the deployed VM will use.

The selected network should allow the appliance to reach out to Internet for support and upgrade.
To customize the template for the deployment, you will have to manually configure the appliance
using the VM console. Click Next.

Verify the configuration details and click Finish.

Once the platform is installed, start the VM and launch the console.

Log in with the given console credentials. Run the setup command.

Create the password for the support login. Change the password for the consoleuser.
Enter the following details to configure the network:

a IPv4 Address: Second reserved static IP address

b Netmask: Subnet mask for the above static IP

¢ Default Gateway: Default gateway of your network

d DNS : DNS server of your environment
Note For multiple DNS servers, ensure that they are separated by space.

e Domain Search List : The domain that needs to be appended for dns lookups

f  Enter y to save the configuration.

Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start if NTP
time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.

To configure Web proxy, enter y. This is an optional configuration.
To configure Health Telemetry, enter y. This is an optional configuration.

All the services are verified.

19
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Deployment Using vSphere Windows Native Client

You can deploy vRealize Network Insight using vSphere Windows native client.

Procedure

1 Click File > Deploy OVF Template.

2 Enter the URL to download and install the OVA package from the internet or browse to select the
source location of the OVA package on your computer.

3 Click Next and verify the OVF template details.

4 Read the End-User License Agreement and click Accept.

5 Provide a name and specify the location for the deployed template. Click Next.

6 Select the Deployment Configuration.

7 Select a Host/Cluster where you want to run the deployed template.

8 Select the Resource Pool in which you want to deploy this template.

9 Select a destination storage for the VM files. Click Next.

10 Specify the format in which you want to store the virtual disks. Select Thin Provision as the virtual
disk format. Click Next.

11 Specify the network that the deployed template should use. Map the network from OVA to your
inventory.

12 Customize the template for the deployment. Provide the shared secret that was generated on the
onboarding page. You will have to manually configure the appliance using the VM console. Click
Next.

13 Verify all the configuration data. Check Power on after deployment. Click Finish.

14 Once the Collector OVA is installed, start the VM and launch the console.

15 Log in with the given console credentials. Run the setup command.

16 Create the password for the support login. Change the password for the consoleuser.

17 Enter the following details to configure the network:

a |IPv4 Address: Second reserved static IP address
b Netmask: Subnet mask for the above static IP
¢ Default Gateway: Default gateway of your network

d DNS : DNS server of your environment

Note For multiple DNS servers, ensure that they are separated by space.

VMware, Inc. 20
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e Domain Search List : The domain that needs to be appended for dns lookup.

f  Enter y to save the configuration.

Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start if NTP
time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.

To configure Web proxy, enter y. This is an optional configuration.
To configure Health Telemetry, enter y. This is an optional configuration.

All the services are verified.

Activating the License

After installing the vRealize Network Insight Platform OVA, open https.//<vRealize Network Insight
Platform IP address> in the Chrome Web browser.

Procedure

1
2

Enter the license key received in the welcome email.

For Ul admin (admin@local) user name, set the password. If you are a support user or a CLI user,
refer Default Login Credentialsfor the password.

Click Activate.

Add the vRealize Network Insight Collector after activating the license.

Generating Shared Secret

You can generate and import the vRealize Network Insight proxy virtual appliance.

Generate a shared secret and import the vRealize Network Insight proxy virtual appliance:

Procedure

1
2

Generate a shared secret after activating the license on the Setup Proxy Virtual Appliance page.
Copy the shared secret.

You will require this during the deployment of vRealize Network Insight Proxy OVA.

Setting up Network Insight Collector (OVA)

You can set up vRealize Network Insight collector by importing OVA to your vCenter server.

Follow the steps below to import the vRealize Network Insight collector OVA to your vCenter Server.

Deployment Using vSphere Web Client

You can import the vRealize Network Insight Collector OVA using vSphere Web Client.

VMware, Inc. 21
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Procedure

1 Right-click the Datacenter where you want to install the appliance and select Deploy OVF Template.

2 Enter the URL to download and install the OVA package from the internet or browse to select the
source location of OVA from your computer.

3 Provide a name and specify the location for the deployed template. Click Next.

4 Select a resource (host or a cluster) where you want to run the deployed template. Click Next.

5 Verify all the details of the template. Click Next.

6 Read the End-User License Agreement and click Accept. Click Next.

7 Select a deployment configuration. Click Next.

8 Select the location where you want to store the files for the deployed template. Specify the format in
which you want to store the virtual disks. Select Thin Provision as the virtual disk format. Select the
Datastore in which you want to install the files. Click Next.

9 Specify the destination network for the source network. Click Next.

10 Customize the template for the deployment. Provide the shared secret that was generated from the
Ul. You will have to manually configure the appliance using the VM console. Click Next.

11 Verify all the configuration data. Click Finish.

12 Once the Collector OVA is installed, start the VM and launch the console.

13 Log in with the given console credentials. Run the setup command.

14 Create the password for the support login. Change the password for the consoleuser.

15 Enter the following details to configure the network:

a IPv4 Address: Second reserved static IP address
b Netmask: Subnet mask for the above static IP
¢ Default Gateway: Default gateway of your network
d DNS : DNS server of your environment
Note For multiple DNS servers, ensure that they are separated by space.
e Domain Search List : The domain that needs to be appended for dns lookups
f  Enter y to save the configuration.

16 Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start if NTP

time is out of sync.
Note For multiple NTP servers, ensure that they are separated by commas.
17 A check is made to see if the shared secret key has been configured. The proxy is paired with the

corresponding platform. This may take few minutes.

VMware, Inc. 22
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18 To configure Web proxy, enter y. This is an optional configuration.
19 To configure Health Telemetry, enter y. This is an optional configuration.
20 All the services are verified.

21 Click Finish, once Proxy Detected! message is displayed on the onboarding page. It will redirect to
the Login Page.

Deployment using vSphere Windows Native Client

You can import the vRealize Network Insight Collector OVA using vSphere Windows native client.

Procedure
1 Click File > Deploy OVF Template.

2 Enter the URL to download and install the OVA package from the internet or browse to select the
source location of the OVA package on your computer.

Verify the OVF template details. Click Next.

Read the End-User License Agreement and click Accept. Click Next.

Provide a name and specify the location for the deployed template. Click Next.
Select a Deployment Configuration. Click Next.

Select a Host/Cluster where you want to run the deployed template. Click Next.

Select the Resource Pool in which you want to deploy this template. Click Next.

© 00 N o a »~» O

Select a destination storage for the VM files. Click Next.

10 Specify the format in which you want to store the virtual disks. the Select Thin Provision as the
virtual disk format. Click Next.

11 Specify the network that the deployed template should use. Map the network from OVA to your
inventory.

12 Customize the template for the deployment. Provide the shared secret that was generated on the
onboarding page. You will have to manually configure the appliance using the VM console. Click
Next.

13 Verify all the configuration data. Check Power on after deployment. Click Finish.
14 Once the Collector OVA is installed, start the VM and launch the console.
15 Log in with the given console credentials. Run the setup command.
16 Create the password for the support login. Change the password for the consoleuser.
17 Enter the following details to configure the network:
a IPv4 Address: Second reserved static IP address
b Netmask: Subnet mask for the above static IP

c Default Gateway: Default gateway of your network
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18

19

20
21
22
23

d DNS : DNS server of your environment
Note For multiple DNS servers, ensure that they are separated by space.

e Domain Search List : The domain that needs to be appended for dns lookup.

f  Entery to save the configuration.

Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start if NTP
time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.

A check is made to see if the shared secret key has been configured. The proxy is paired with the
corresponding platform. This may take few minutes.

To configure Web proxy, enter y. This is an optional configuration.
To configure Health Telemetry, enter y. This is an optional configuration.
All the services are verified.

Click Finish, once Proxy Detected! message is displayed on the onboarding page. It will redirect to
the Login Page.

Deploy Additional Proxy to an Existing Setup

You can add additional vRealize Network Insight proxy to an existing setup.

Procedure

1

2
3
4

Log into the vRealize Network Insight Ul. Navigate to Settings > Install and Support.
Click Add Proxy VM.
Copy the shared secret from the dialog that is displayed.

Follow the steps in section Setting up Network Insight Collector (OVA) in step 3.

Default Login Credentials

vRealize Network Insight has three types of users. The login credentials for these users are as follows:

Note Use Google Chrome to log in to vRealize Network Insight.
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Table 2-1.
Types of Users User name Password
Admin Ul admin@local Set this password in the
Activate License window
during installation.
SSH User support Set this password during
installation.
CLI User consoleuser Set this password during
installation.
Procedure

1 Navigate to https:/<vRealize Network Insight Platform IP address>.

2 Log in to the product Ul with the corresponding user name and password.

NSX Assessment Mode for Evaluation License

vRealize Network Insight starts in the NSX assessment mode when you use the evaluation license.

You can add a data source to vRealize Network Insight, analyze traffic flow, and generate reports.

Note To switch to the Full Product mode, click Switch to Full Product Evaluation located in the bottom

right corner.

Add vCenter Server

You can add vCenter Servers as data source to vRealize Network Insight.

Multiple vCenter Servers can be added to vRealize Network Insight to start monitoring data.

Procedure

1 Click Add vCenter.

2 Click Add new source and customize the options.

Option
Source Type
IP Address/FQDN

Username

Password

3 Click Validate.

Action
Select the vCenter Server system from the drop-down menu.
Enter the IP address or fully qualified domain name of the vCenter Server.

Enter the user name, with the following privileges:
= Distributed Switch: Modify
m  dvPort group: Modify

Enter the password for vRealize Network Insight software to access the vCenter
Server system.

4 Select Enable Netflow (IPFIX) on this vCenter to enable IPFIX.

VMware, Inc.
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5 Add advanced data collection sources to your vCenter Server system.

6 (Optional) Click Submit to add the vCenter Server system. The vCenter Server systems appear on
the homepage.

Analyze Traffic Flows

You can use vRealize Network Insight to analyze flows in your datacenter.

Prerequisites

At least two hours of data collection must occur before starting the flow analysis.

Procedure

1 Specify the scope of the analysis. For example, if you are interested in flows of all virtual machines in
a Cluster, select Cluster from the dropdown menu. You can alternately select all virtual machines
connected to a VLAN or VXLAN.

2 Select the entity name for which you want to analyze the flows.

3 Select the duration and click Analyze.

Generate a Report

You can generate a report of the flow assessment.

Prerequisites

Analyze traffic flows in the datacenter. For comprehensive reports, collect 24 hours of data before the
analysis.

Procedure
1 Inthe EVAL NSX Assessment Mode, click Generate Report in the Analyze Flows page.

2 Inthe Non EVAL Mode, on the Microsegmentation page, click Traffic Distribution > More
Options > Assesment Report.

Adding Data Sources

After you log in, add the various data sources to vRealize Network Insight for the software to monitor your
data center.

The product will start showing the data from your environment after two hours of data collection.

Procedure

1 Select Profile > Settings.

2 Click the Add new source button.
3 Select the Source Type.
4

Enter the required details and click Submit to add the Data source.
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5 Repeat the above steps to add all the required data sources from your environment.
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Scaling up of a Platform or
Collector Appliance

The process of scaling up of a platform or a proxy appliance implies changing its brick size from MEDIUM
to LARGE.

If a platform is of LARGE brick size, then you have to scale up by adding more platform nodes such as
creating a platform cluster. After a proxy is of LARGE brick size, then you have to add more proxies.

The steps to scale up vRealize Network Insight Virtual Appliance from MEDIUM brick to LARGE brick are as

follows:

1

a A W N

Log in to vCenter.

Increase the RAM of the VM to at least match the LARGE brick size requirements.
Increase the vCPU count of the VM to at least match the LARGE brick size requirements.
Refer to the brick size in the Privileges section.

Restart the VM.
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Planning to Scale up the
Platform Cluster

Three or more LARGE platform bricks can be connected together to form a platform cluster.

Note Ensure that you take a backup of the Platform1 node before you create clusters. Refer to VMware
best practices to take the backup of virtual machines (like VMware VDP using VADP). Restore the
Platform1 node from backup if there is an unrecoverable error while creating the cluster. It is
recommended that you use cleanly deployed platform nodes while creating clusters. Redeploy the new
platform nodes (p2-pn) before restarting cluster creation process if there is an unrecoverable error.

To decide the required number of platform bricks:

Number of bricks needed = Round off to next Integer ((Total number of managed VMs) /
(Capacity of LARGE Platform brick in table above))

Scaling up Scenarios for the Platform Cluster

= Scenario 1

a Assume that on January 1st (today), the datacenter has 2000 VMs (with flows) across many
vCenters.

b  Assume that in March, the number of VMs grows to 3100.

¢ Assume that in June, the number of VMs grows to 6100 which could be because of the additions
of few more vCenters or the expansion of the existing vCenters.

d Assume that in December, the number of VMs grows to 18100 (with flows).
The deployment model for this scenario is as follows:

a On January 1, deploy a single platform node with the MEDIUM brick size.
b In March, scale up the platform node to the LARGE brick size.

¢ InJune, scale out the platform, convert to a three node platform cluster by adding new Platform
nodes to the existing Platform.

d In December, the user needs a four node platform cluster.

m  Scenario 2

a Assume that on January 1st (today), the datacenter has 7000 VMs (with flows) across many
vCenters.
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b  Assume that in June, the number of VMs grows to 15000 (with flows).

¢ Assume that in December, the number of VMs grows to 24000 (with flows).
The deployment model for this scenario is as follows:

a OnJanuary 1, deploy a three node platform cluster.

b InJune or later, as the environment size gets closer to exceeding 18000, the user needs a four
node platform cluster.

¢ In December, as the environment size gets closer to exceeding 24000, the user needs a five
node platform cluster.

VMware, Inc.
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Planning to Scale up the Proxy
Server

The scaling up of the proxy node is independent of the platform nodes in the cluster. Typically, the users
install one or more proxy VMs per site. Within a site, the number of proxy VMs needed is a simple
function of total number of VMs for which it has to collect data. Refer to the capacity of proxy VMs in the
brick size table in the System Requirements section.

You can add a data source (maybe a vCenter or a switch) to exactly one proxy VM.

Scaling up Scenarios for the Proxy Server

VMware, Inc.

Scenario1: Suppose there are 2000 VMs in a vCenter.

Install one medium proxy VM. Assign the vCenter to this proxy using the product Ul.

Scenario 2: 1000 VMs in vCenter1 and 2000 VMs in vCenter2 (all of them are in one data center)
Install one medium Proxy VM. Assign both vCenters to this proxy using the product Ul.

Scenario 3: 1000 VMs in vCenter 1 and 2000 VMs in vCenter2 (all of them are in the same data
center)

Install one medium Proxy VM. Assign both vCenters to this proxy using the product Ul.
Scenario 4: 1000 VMs in vCenter1 (data center1) and 2000 VMs in vCenter2 (data center2)

Install one medium Proxy VM in each data center. Assign vCenter1 to proxy VM in same data center
using Product Ul. Assign vCenter2 to Proxy VM in its data center using the product Ul.

Scenario 5: 9,000 VMs in vCenter1 without flows (data center1)
Install one large proxy brick. Assign this vCenter to this proxy using the product Ul.
Scenario 6: 11,000 VMs in vCenter1 with flows (data center1)

This scenario is not supported. Maximum number of VMs that can be managed by one proxy VM is
10,000 without flows OR 6,000 with flows. And one vCenter can be added to only one proxy at a time.

Scenario 7: vCenter1 with 2000 VMs in January, vCenter2 with 5000 VMs in June

Install one medium Proxy VM in January and assign vCenter1 to it. Install the second large proxy VM
in June and assign vCenter?2 to it.
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Proxy VMs with a Platform Cluster

The number of proxy VMs does not depend on the number of VMs in a platform cluster. All proxy VMs
communicate only to the first platform VM (platforml in the following example) in a platform cluster. A
few example deployment models that are supported are as follows:

m  Case 1: A proxy VM connects to a platform cluster.
The proxy connects to platforml.
m  Case 2: Many Proxy VMs connect to a platform cluster

All the proxies are connected to platforml. And then platforml VM load balances both proxy
requests and the data processing to other platform VMs in this cluster internally automatically.

= Case 3: A proxy VM connects to the single platform node deployment

= Case 4: Many proxy VMs connect to one platform node deployment

VMware, Inc.
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Expanding a Cluster

The cluster expansion feature enables you to add the platform nodes to any existing old and new cluster
without incurring any data loss.

Note Ensure that you take a backup of all the Platform nodes before you create clusters. Refer to the
VMware best practices to take the backup of virtual machines (like VMware VDP using VADP). Restore
the Platform nodes from the backup if there is an unrecoverable error.

For example, if you have an existing cluster with three nodes, you can add 4 more nodes to it without any
data loss.

Procedure
1 On the Install and Support page, click Expand Cluster for Platform VMs.
2 The IP addresses of the VMs that are part of the cluster already are listed on the Expand Cluster

page. To add one or more nodes to the existing cluster, provide the IP address of the node and the
support user password.

Note

= Currently, vRealize Network Insight supports 10 nodes in an existing cluster. Once the limit is
reached, the Add more button is disabled.

= Ensure that all the new nodes are non-provisioned and are reachable through SSH.

= Ensure that you have taken a backup of the existing platform VMs before you go ahead with the
cluster expansion.

3 Click Submit.
The step-by-step progress is displayed.
4 Once the cluster expansion link is completed, a message indicating success is displayed.

While the cluster expansion is in progress, the application cannot be used for any other operation.
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Upgrading vRealize Network
Insight

You can upgrade your current vRealize Network Insight environment to the latest version.

In vRealize Network Insight, you can upgrade to 3.9 version from the 3.8 version and the 3.7 version from
the same upgrade bundle.

3.7->3.9

3.8->3.9

The supported upgrade path is:
3.0->3.1->3.2->3.3->3.4->3.5->3.6->3.7->3.8->3.9

From Release 3.5 onwards, jump upgrades are supported. For example:
3.0->3.1->3.2->3.3->3.4->3.5->3.7->3.9

From Release 3.8 onwards, you can perform the cluster upgrade online. vRealize Network Insight
provides the following three modes of upgrade:

This chapter includes the following topics:
= Online Upgrade

m  Single-Click Offline Upgrade

m  Offline Upgrade

Online Upgrade
Whenever there is a new version of vRealize Network Insight available, you receive a natification.

Prerequisites
Ensure that the following disk space requirements are met before going ahead with the upgrade:
= The following requirements are for both platform and proxy server:

= /tmp-6GB

= /home -2 GB
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/- 6 GB (Only for the Platform1 node)

Note This requirement is only for the platform.

If the bandwidth is insufficient to download the upgrade bundle from the server, then the upgrade fails.
The minimum bandwidth required is 500 KB/s. The Install and the Support page throws an error if the
download bandwidth check fails.

Note The download bandwidth check is not applicable when upgrading from 3.8 to 3.9. But from 3.9 to

all future upgrades this will be applicable.

Procedure

1

To enable online upgrade, you have to contact the VMware support. Verify the upgraded version from
the product Ul under Settings page to be one that is mentioned in the update.

Note

If the update notification is not available, verify that both vRealize Network Insight Platform and
Proxy VMs have connectivity to svc.ni.vmware.com on port 443 and reg.ni.vmware.com on
port 443 by running the show—-connectivity-status command. If this connectivity requires
http proxy, configure it on each VM using the set-web—proxy command. Ensure that the
output contains upgrade connectivity status as Passed.

File a support ticket and provide the service tag from the product Ul. The service tag is shown
under Settings.

Provide a screenshot of the show-connectivity-status command output from each vRealize
Network Insight Platform and Proxy VMs.

Check if the update notification is available on the Install and Support page under Settings.

Click View details to view details of update.

Click Install Now on the details page to download and upgrade the vRealize Network Insight

deployment.

Note

Ensure that all the nodes are online before beginning the upgrade. If any node is inactive before
the upgrade begins, you will not be allowed to trigger the upgrade.

Once the upgrade begins, if a node becomes inactive, the upgrade process does not continue.
The upgrade will not resume until the node becomes active again.

The Platform1 becomes the upgrade server here. If Platform1 is offline, then no other node is
upgraded.

Single-Click Offline Upgrade

VMware, Inc.

35



Installing vRealize Network Insight

vRealize Network Insight supports the single-click offline upgrade of the product from Release 3.7 to the
future releases such as 3.7->3.8, 3.7->3.9, 3.8->3.9, and so on.

Ensure that the following disk space requirements are met before going ahead with the upgrade:
= The following requirements are for both platform and proxy server:
= /tmp-6 GB

= /home -2 GB
m /- 12 GB (Only for the Platform1 node)

Note This requirement is only for the platform.

Procedure

1 Ensure that you have saved the update package to your local disk so that you can upload it on this
page. Click Browse to select the file and click Upload.

2 Onthe Install and Support page, under Software version, click Click here.

Install and Support

Overview [View Details ]

Health ® Good

Support Tunnel

Software version 3.70.1518702094 [Latest version, last updated on Feb 15 at 20:17 ]
Want to update using an update package ? Click here

Utilization 130f600VMs ©

Platform VMs

3 After the upload is complete, a dialog box with the basic upgrade instructions appears before the
upgrade begins. To proceed further, click Install Now.

4 Once the upgrade process begins, a pop-up window appears. This pop-up window provides the
status of each node.

Note
m  Ensure that all the nodes are online before beginning the upgrade. If any node is inactive before
the upgrade begins, the upgrade is not triggered.

®  Once the upgrade begins, if a node becomes inactive, the upgrade process does not continue.
The upgrade will not resume until the node becomes active again.

= Until the upload of the package happens, the user should take care that the session is not closed.
If the session ends, the user has to restart the upload process.

m  The Platform 1 becomes the upgrade server here. If Platform1 is offline, then no other node is
upgraded.
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5 Upon the completion of upgrade process, all platforms and the collectors nodes are upgraded.

Offline Upgrade

Consider offline upgrade only if both online upgrade or single-click offline upgrade don't work. Use this
option when both vRealize Network Insight Platform and Proxy VMs do not have access to the internet.
You must upgrade Platform VMs before Proxy VMs.

Prerequisites

In case of the cluster upgrade, platforml must be upgraded first. To confirm platform1 IP address, run
the ping platforml command from any platform node.

Procedure

1 Download the required upgrade bundle file from My VMware.

2 Copy the upgrade bundle to all vRealize Network Insight Platform and Proxy VMs by using either of
the following options:

a To copy the file from Linux VM to vRealize Network Insight VM, run this command:

scp <filename>.upgrade.bundle consoleuser@<IP_Address_vRNI_VM>:~/

To copy file from Windows VM to vRealize Network Insight VM, run this command:

Note Use the pscp utility from https://the.earth.li/~sgtatham/putty/latest/w64/pscp.exe.
pscp —-scp <SOURCE_PATH>\<filename>.upgrade.bundle consoleuser@<IP_Address_vRNI_VM>:~/

b Log in to the vRealize Network Insight Platform CLI using consoleuser and run this command:
Note This command uses SCP to download the bundle from the host where the bundle is
downloaded. So the SCP server is required to be running on the host.

package-installer copy —-host <ip address> —-user johndoe ——
path /path/to/<filename>.upgrade.bundle
3 Upgrade each node starting with Platform1 node using the package-installer upgrade command.

For the 3.5 version, run the command as follows:
package-installer upgrade —--name VMWare-vRealize-Network-Insight-<version_numbers>.upgrade.bundle
For 3.4 and the preceding versions, run the command as follows:

package-installer upgrade
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4 Verify the upgraded version using the show-version command.

Note
= Ensure that you verify the checksums for the upgrade bundle as specified.

= You can upgrade the cluster only in the offline mode.

m  After a successful upgrade, you do not have to reboot the virtual machine.
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